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1. Коришћење шаблона 
Аутори радова користе искључиво овај 
званични шаблон, који је припремило 
уредништво часописа. Правилном применом 
шаблона помажете уредништву да ваш рад 
припреми за публиковање и штампу у што 
краћем року. 
Молимо вас да за припрему рада користите 
новије верзије програма Microsoft Word. 
Шаблон неће правилно функционисати у 
верзијама старијим од издања из 2016. године. 
Основни формат датотеке мора бити .docx, 
молимо вас да документ не чувате у 
формату .doc 
Шаблон садржи предефинисане стилове који 
се морају користити приликом припреме 
рукописа. 
Текст који је стављен у угласте заграде и који је 
обојен наранџастом бојом немојте мењати – 
пример: <овако означен текст не мењати> 
За припрему рада и форматирање текста 
користите искључиво предефинисане стилове. 
Немојте ручно подешавати величину, боју 
или размак текста. 
Сви предефинисани стилови се налазе на 
локацији Home>Styles (Слика 1). 

 
Слика 1. Стилови за форматирање текста 

1.1 Предефинисани стилови 
У оквиру овог шаблона дефинисани су следећи 
стилови који се морају користити ради 
аутоматског форматирања текста: 

• Title;Naslov 
Користи се за форматирање наслова 

• Autori/Authors 
Користи се за форматирање имена и 
презимена аутора 

• Afilijacija/Afilliation 
Користи се за форматирање текста 
афилијације аутора 

• Apstrakt / Abstract 
Користи се за форматирање текста 
апстракта 

• Normal; Tekst rada 
Користи се за форматирање текста 
рада 

• Heading 1 
Користи се за форматирање наслова 
првог реда 

• Heading 2 

Користи се за форматирање 
поднаслова другог реда 

• Heading 3 
Користи се за форматирање 
поднаслова трећег реда 

• Bullet paragraph list 
Користи се за форматирање листе са 
маркерима 

• List Paragraph 
Користи се за форматирање 
нумерисане листе 

• Potpisi slika tabela / Caption 
Користи се за форматирање потписа 
слика и табела 

Стилови се примењују тако што се означи 
жељени текст и из листе стилова (Home > 
Styles) изабере одговарајући стил. Овим 
поступком се аутоматски подешавају тип и 
величина фонта, размаци између пасуса, 
нумерација наслова и поднаслова, маркери у 
листама и остали елементи форматирања.  
2. Поглавља и потпоглавља 
Приликом форматирања рада користе се 
највише три нивоа поглавља и потпоглавља, 
која се аутоматски нумеришу. Нумерисање се 
врши избором одговарајућег стила из падајуће 
листе стилова (Home > Styles). 
3. Главно поглавље 
Главно поглавље се форматира тако што се 
означи (select) текст наслова, а затим из 
падајуће листе стилова (Home > Styles) изабере 
стил Heading 1. 

3.1 Поглавље првог нивоа 
Потпоглавље првог нивоа се форматира тако 
што се означи текст наслова, а затим се из 
падајуће листе стилова (Home > Styles) изабере 
стил Heading 2. 

3.1.1 Поглавље трећег нивоа 
Потпоглавље другог нивоа се форматира тако 
што се означи текст наслова, а затим се из 
падајуће листе стилова (Home > Styles) изабере 
стил Heading 3. 
Листе са маркерима форматирају се тако што 
се означе (select) жељени елементи листе, а 
затим се из листе стилова изабере стил Bullet 
paragraph list: 

• Прва ставка маркер листе; 
• Друга ставка маркер листе; 
• Трећа ставка маркер листе. 

Нумерисане листе форматирају се тако што се 
означи (select) жељена листа, а затим се из 
листе стилова изабере стил List Paragraph: 

1. Прва ставка нумерисане листе; 



2. Друга ставка нумерисане листе; 
3. Трећа ставка нумерисане листе; 

Уколико се касније у тексту поново користи 
нумерисана листа, нумерација ће се 
аутоматски наставити од претходне. Ако је 
потребно да се нумерација поново започне од 
броја 1, потребно је означити бројеве нове 
листе, кликнути десним тастером миша и 
изабрати опцију Restart at 1. 
4. Начелни садржај поглавља 
Начелни садржај поглавља научног рада је 
следећи: 

1. Увод 
2. Методологија 
3. Резултати 
4. Дискусија 
5. Закључак 
6. Литература 

Рецензије и други типови чланака могу имати 
флексибилнију структуру, прилагођену 
предмету и проблематици која се обрађује. 
Увод треба да буде јасан и концизан, почевши 
од ширег контекста теме и постепено се 
фокусирајући на конкретан проблем који рад 
третира. Важно је нагласити значај теме и 
разлоге због којих је истраживање важно. 
Треба укратко прегледати најрелевантније 
претходне радове како би се рад сместио у 
постојећи научни оквир, али без сувишних 
детаља. Јасна формулација циљева и хипотеза 
рада је неопходна, а стил писања треба бити 
приступачан и разумљив и за научнике ван 
ужег поља. Пожељно је на крају увода дати 
кратак преглед структуре рада како би 
читаоци знали шта могу очекивати. 
Поглавље методологије треба да прецизно и 
детаљно опише све коришћене методе, 
материјале и поступке, како би други 
истраживачи могли да понове истраживање. 
Објасните разлоге за избор одређених техника 
и метода, као и услове и карактеристике 
узорка. Статистичке и друге анализе треба 
јасно навести и образложити. Језик треба да 
буде прецизан али и довољно јасан, са 
објашњењем стручних термина ако је 
потребно, како би информације биле 
приступачне што ширем кругу читалаца. 
Молимо вас да имате на уму да објављивање 
вашег рада подразумева да морате учинити 
све материјале, податке, компјутерски код и 
протоколе који су повезани са публикацијом 
доступним читаоцима. Молимо вас да у фази 
подношења откријете евентуална ограничења 
у доступности материјала, података или 
других информација. Нове методе и протоколи 
треба да буду детаљно описани, док се опште 

утврђене методе могу укратко описати и 
адекватно цитирати. 
Научни и прегледни радови који извештавају о 
великим скупима података који су депоновани 
у јавно доступној бази података треба да 
наведу где су подаци депоновани и обезбеде 
релевантне бројеве приступа. Ако бројеви 
приступа још нису добијени у тренутку 
подношења, молимо вас да наведете да ће бити 
достављени током рецензије. Они морају бити 
достављени пре објављивања. 
Студије које укључују интервенције на 
животињама или људима, као и друге студије 
које захтевају етичко одобрење, морају 
навести орган који је издао одобрење и 
одговарајући етички код. 
У овој секцији, где је примењиво, аутори су 
обавезни да открију детаље о томе како је 
генеративна вештачка интелигенција (GenAI) 
коришћена у овом раду (нпр. за генерисање 
текста, података или графике, или за помоћ у 
дизајнирању студије, прикупљању података, 
анализи или интерпретацији). Коришћење 
GenAI за површинско уређивање текста (нпр. 
граматика, правопис, интерпункција и 
форматирање) не мора бити декларисано. 
У делу резултати представите резултате 
истраживања на прецизан и логичан начин, 
користећи табеле, графиконе и друге визуелне 
елементе за боље разумевање података. У 
тексту се фокусирајте на кључне налазе, али их 
немојте тумачити нити коментарисати. 
Резултати треба да буду изложени објективно 
и јасно, без понављања, како би читалац могао 
лако да прати информације. 
У дискусији покушајте да сажето тумачите 
резултате у светлу постављених циљева и 
претходних истраживања. Објасните да ли су 
хипотезе потврђене или одбачене и који је 
значај ваших налаза за научну заједницу. Ако 
су резултати неочекивани или у супротности 
са општим начелима или туђим резултатима, 
понудите могућа објашњења. Будите искрени у 
опису ограничења и слабости истраживања, 
као и у давању препорука за даља проучавања 
или примену резултата. Ово поглавље треба да 
буде аналитичко и критичко. 
Закључак треба да буде концизан и јасан 
осврт на најважније налазе  тј. резултате рада, 
наглашавајући његов допринос и значај. Треба 
избегавати увођење нових података или идеја, 
а тон писања бити уверен и позитиван. Циљ је 
да читалац лако схвати најбитније поуке из 
вашег рада и његов значај за поље. Овај део 
није обавезан, али се може додати самом раду 
ако је дискусија необично дуга или сложена. 



Приликом навођења литературе обавезно 
користите доследан и прописан стил 
цитирања. Сви извори наведени у литератури 
морају бити цитирани у тексту, а свака 
референца мора бити потпуна и прецизна. 
Важно је да користите проверене и релевантне 
изворе и да уједначите формат свих навода. 
Код електронских извора обавезно наведите 
датум приступа. 
Референце у оквиру текста наводе се 
латиничним писмом у загради, по следећем 
формату: један аутор – (Smith, 2025), два 
аутора – (Smith & Johnes, 2025), три или више 
аутора – (Smith et al., 2025). За навођење 
литературе користи се APA стил (APA standard 
referencing style). Подаци о коришћеним 
изворима наводе се на крају документа. 
5. Слике, илустрације, графике 
Слике могу бити једно стубачне, 1.5 стубачне, 
двостубачне и преко целе стране (тзв. Plate). 
Слике се додају као објекти, користећи 
команду Insert>Pictures>This Device (Слика 2). 

Једно стубачне слике је потребно припремити 
тако да буду максималне ширине до 7,8 cm. 
1.5 стубачне слике припремити тако да буду 
максималне ширине 11,7 cm. 
Слике преко целе стране (Plate) припремити 
тако да буду максималне ширине 17 cm. 
Након додавања слике у текст рада, потребно 
је поставити опцију Layout options тако да буде 
одабрана опција With text wrapping > Square. 
Опција за ова подешавања се активира тако 
што се мишем кликне на слику и потом се 
одабере иконица  која се појављује у горњем 
десном углу додате слике (Слика 3). 

 
Слика 3. Подешавање Layout Options након додавања 

слике у текст 

Након овог корака могуће је подешавање 
величине слике. То се постиже тако што се 
одабере жељена слика, затим се у менију 
Picture Format одабере таб Size, и у поље Width 
унесе жељена ширина слике, у складу са 
претходно дефинисаним вредностима. Слике 
је потребно центрирати. 
а овај начин, слике које су шире од једног 
ступца биће форматиране тако да буду 
окружене текстом. 
Потпис испод слике (Слика 4) се додаје тако 
што се слика означи, затим се десним кликом 
миша одабере опција Insert Caption, а у пољу 
Label изабере ознака Слика. 

 
Слика 4. Додавање потписа слике 

Све графичке прилоге потребно је припремити 
у резолуцији која обезбеђује јасноћу и 
очуваност детаља, без тзв. пикселизације. 
Препоручена минимална резолуција је 300 dpi. 
Слике је неопходно додати у текст на жељено 
место, али је потребно припремити их и као 
посебне фајлове и приложити их приликом 

Слика 2. Додавање слика у текст рада 



предаје рада у одговарајућем панелу 
платформе за предају рада (OJS). 
Уколико нисте у могућности да форматирате 
слике и додате слике у складу са овим 
упутством, молимо вас да на месту где је 
потребно уметање слике унесете ознаку: 
СЛИКА Х ОВДЕ У том случају, потребно је 
припремити посебан фајл са насловима слика 
који ћете приложити приликом предаје рада у 
одговарајућем панелу платформе за предају 
рада (OJS). 
Графикони се припремају као слике и додају се 
у текст по истом поступку као и слике. 
Уколико се у рукопису користе слике, 
илустрације или било који графички 
материјали који су већ објављени у другим 
изворима, неопходно је обезбедити 
одговарајућу дозволу за њихово поновно 
коришћење. Аутори су обавезни да наведу 
извор оригиналне илустрације и, уколико је 
потребно, доставе писмену сагласност носиоца 
ауторских права. Ово се односи како на научне 
чланке и књиге, тако и на онлајн садржаје и 
друге медије. 
Свака претходно публикована слика мора бити 
јасно означена у потпису уз напомену о извору 
(нпр. Преузето са: Аутор, година, наслов 
публикације, издавач). Уколико је извршена 
модификација оригиналне илустрације, то 
такође треба нагласити (нпр. Измењено 
према:...). Недозвољено је преправљање или 
уклањање изворних елемената без адекватне 
евиденције и дозволе. 
Аутори су одговорни за све евентуалне 
повреде ауторских права настале услед 
некоректног коришћења туђих материјала. 
Уредништво задржава право да уклони или 
одбије рад уколико се установи непоштовање 
ових правила. 
6. Табеле 
Табеле могу бити једно стубачне, 1.5 стубачне, 
и двостубачне тј. преко целе стране.  
Једно стубачне табеле је потребно припремити 
тако да буду максималне ширине до 7,8 cm. 
1.5 стубачне табеле припремити тако да буду 
максималне ширине 11,7 cm. 
Двостубачне табеле припремити тако да буду 
максималне ширине 17 cm. 
Табеле се додају одабиром опције Insert > Table 
са жељеним бројем редова и колона. 
Потпис изнад табеле (Табела 1) се додаје тако 
што се табела означи, затим се десним кликом 
миша на крстићу који ће се појавити  у горњем 
левом углу табеле одабере опција Insert 
Caption, а у пољу Label изабере ознака Табела и 
одабере се опција Position > Above table. 

Садржај колона и табела је потребно 
прилагодити тако да текст буде читљив и 
прегледан. 
Уколико је табела шира од једног ступца, 
потребно је означити табелу, затим десним 
кликом миша на крстићу који ће се појавити  у 
горњем левом углу табеле одабрати опцију 
Table Properties > Text Wrapping > Arround. Након 
овог подешавања могуће је подешавање 
табеле на жељене димензије развлачењем 
ширине или подешавањем у оквиру опција 
Table Layout.  
Табела 1. Пример једно стубачне табеле са 2 колоне и 

три реда 

Уколико нисте у могућности да форматирате и 
додате у текст рада табеле у складу са овим 
упутством, молимо вас да на месту где је 
потребно уметање табеле унесете ознаку: 
ТАБЕЛА Х ОВДЕ. У том случају, потребно је 
припремити посебан фајл са табелама и 
њиховим насловима који ћете приложити 
приликом предаје рада у одговарајућем панелу 
платформе за предају рада (OJS). 
7. уношење и форматирање 

математичких образаца  
Математички изрази и формуле треба да буду 
унети користећи уграђени алат Equation у 
Microsoft Word-у, што омогућава доследан 
изглед и правилно форматирање у оквиру 
документа. 
Унос формуле 

1. Поставите курсор на место у тексту где 
желите да унесете формулу. 

2. Идите на картицу Insert (Уметање). 
3. Кликните на Equation (Формула) у 

групи Symbols. 
4. Отвориће се поље за унос формуле. 

Можете: 
• Унети формулу помоћу тастатуре (нпр. 

E=mc^2) 
• Користити уграђене симболе и 

шаблоне (разломци, интеграли, 
матрице, итд.) који се налазе у Equation 
Tools > Design. 

Форматирање формула 
• Формуле се могу уносити у линији са 

текстом или као засебан блок 
(центрирано и одвојено од текста). 

• За формуле у блоку, препоручује се да 
се налазе у засебном реду, центриране, 
са празним редом изнад и испод. 

 Колона 1 Колона 2 
Ред 1   
Ред 2   
Ред 3   



• Формуле могу бити нумерисане (по 
потреби) са десне стране. 
Најједноставнији начин је употреба 
табеле са две колоне (без оквира) – у 
левој колони формула, у десној број у 
заградама (нпр. (1)). 

Напомена: сваки симбол, параметар или 
променљива који се јављају у формули морају 
бити објашњени одмах испод формуле, у виду 
кратке легенде. Објашњење треба да буде јасно 
и доследно форматирано, нпр: 

𝑄𝑄 = 𝑚𝑚 ∙ 𝑐𝑐 ∙ ∆𝑇𝑇 (1) 

где је: 
Q – количина топлоте [J] 
m – маса тела [kg] 
c – специфични топлотни капацитет [J/kg·K] 
ΔT – промена температуре [K] 
Савети:  

• Користите Alt + = пречицу на 
тастатури за брзо уметање формуле.  

• Не користите слике формула или 
ручно унесене симболе, јер то отежава 
едитовање и припрему за штампу.  

• Увек проверавајте читљивост, 
симетрију и нумерацију формула. 

Доприноси аутора 
За истраживачке чланке са више аутора, 
потребно је да се обезбеди кратак пасус који 
прецизира њихове појединачне доприносе. 
Ауторство треба бити ограничено на оне који 
су значајно допринели раду који је 
представљен. 
Пример: „Сви аутори су значајно допринели 
настанку овог рада и сагласни су са његовим 
садржајем и редоследом ауторства. [Аутор 1] је 
иницирао/ла истраживање, формулисао/ла 
истраживачко питање, учествовао/ла у 
планирању методологије, прикупљању 
података, статистичкој анализи и писању 
првих верзија рукописа. [Аутор 2] је био/била 
одговоран/на за техничку реализацију, обраду 
и валидацију података, израду табела и 
графичких прилога, као и за уређивање и 
коректуру текста. [Аутор 3] је учествовао/ла у 
интерпретацији резултата, припреми 
литературе, ревизији рукописа и давању 
критичких коментара у циљу унапређења 
научне и језичке прецизности рада. Сви аутори 
су прочитали и сагласили се са објављеном 
верзијом рукописа.“  
Финансирање 
Молимо да додате: „Ово истраживање није 
имало екстерно финансирање“ или „Ово 
истраживање је финансирао ИМЕ 
ФИНАНСИЈЕРА, број пројекта XXX“ Пажљиво 

проверите да су дати подаци тачни и 
користите стандардно писање имена 
финансијских агенција на 
https://search.crossref.org/funding. Грешке 
могу утицати на будуће финансирање. 
Захвалност 
У овом делу можете признати било какву 
подршку која није покривена одељцима о 
доприносима аутора или финансирању. То 
може укључивати административну и 
техничку подршку или донације у натури (нпр. 
материјали коришћени за експерименте).  
Софтвер и GenAI 
Аутори су обавезни да у оквиру рукописа 
укратко наведу све софтверске алате који су 
коришћени током припреме рада, анализе 
података или визуализације резултата, 
укључујући пуно име софтвера, верзију и сврху 
примене (нпр. обрада података, статистичка 
анализа, цртање мапа).  
Пример: „За статистичку анализу коришћен је 
софтвер R (верзија 4.3.1) са пакетима ggplot2 и 
dplyr.“  
Такође, уколико је током израде рада 
коришћена било која генеративна вештачка 
интелигенција GenAI (нпр. ChatGPT, DALL·E, 
GitHub Copilot и сл.), потребно је навести назив 
алата, описати у којем делу рада је примењен и 
у којој мери, као и нагласити да су сви 
генерисани садржаји (текст, код, слике и др.) 
накнадно прегледани и потврђени од стране 
аутора. 
Пример изјаве: „Текстуалне сугестије за уводни 
део рада делимично су генерисане помоћу 
ChatGPT (OpenAI, верзија GPT-4), након чега су 
темељно прегледане, прилагођене и уређене 
од стране аутора.“  
Аутори задржавају пуну одговорност за 
садржај рада, без обзира на степен употребе 
алата базираних на вештачкој интелигенцији. 
Сукоб интереса 
Аутори изјављују да немају било какав 
финансијски, професионални или лични сукоб 
интереса који би могао утицати на 
објективност резултата и тумачење података 
представљених у овом раду. Ниједан од аутора 
није у позицији која би могла изазвати сумњу у 
непристрасност истраживања, нити је било 
директног или индиректног комерцијалног, 
институционалног или личног утицаја на 
израду рукописа. Уколико дође до промене 
околности, аутори ће благовремено 
обавестити уредништво.

https://search.crossref.org/funding


Short title of paper  F. Author, S. Author 
Скраћени наслов рада  П. Аутор, Д. Аутор 

 

Одрицање од одговорности / Напомена издавача: Изјаве, мишљења и подаци садржани у свим публикацијама су 
искључиво мишљење појединачних аутора/аутора и сарадника и не представљају ставове СГД и/или уредника. СГД 
и/или уредници одричу се одговорности за било какве повреде личности или имовине које могу настати као резултат 
било којих идеја, метода, упутстава или производа на које се упућује у садржају. 

8. References - Литература  
За све литературне изворе коришћене у рукопису потребно је појединачно да буду наведене на крају 
рукописа. Препоручујемо коришћење софтвера за управљање библиографијом, као што су EndNote, 
ReferenceManager или Zotero, како би се избегле грешке при куцању и дуплиране референце. За све 
доступне изворе, где је могуће потребно је укључити digital object identifier (DOI). 
Стил навођења референци је АПА (APA) стандард. Постоје многобројне водичи и упутства за 
формирање цитиране литературе као што нпр.: https://guides.libraries.psu.edu/apaquickguide/intext 
Сва цитирана литература се наводи латиничним писмом у абецедном редоследу. 
Пример: 
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